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Abstract Vector-based software has revolutionized scientific
illustrating and is well established in taxonomy. However,
simple line drawings lack depth information. Shading tech-
niques, such as stippling—the application of dots to generate
shade—are the methods of choice for simulating shade, struc-
ture, shape, and texture. In this paper, a step-by-step guide for
digital stippling is presented. Manual stippling offers great
flexibility to achieve highly realistic results. A round brush
is applied to the line art by tapping. To drastically reduce time
consumption and generate homogeneous tinges, a
semiautomation was developed: the smallest units of symmet-
ric stippling patterns are stored in a brush library. Using
macroinstructions (macros), such stored raw patterns are con-
verted into symmetric repetitive patterns. This way, stippling
can be applied quickly and evenly across large areas of the
underlying line drawing. These methods come with all the
advantages of vector illustrations, such as high scalability,
reproducibility and easy correction of strokes that have turned
out imperfect.

Keywords Systematics . Stippling . Shading . Digital
inking . Illustration

Introduction

Line drawings have gone digital. The use of pen tablets for the
creation of biological illustrations is commonly applied across

many organism groups, such as predominantly animal taxa
(various groups of Arthropoda, but also Digenea, Gastrotricha,
Kinorhyncha, Polychaeta, and Vertebrata among others) as well
as fungi (Andres and Overstreet 2013; Barber and Keane 2007;
Coleman and Sen-Dunlop 2013; Ivanova and Wilson 2009;
Kieneke et al. 2008; Reuscher et al. 2009; Salles et al. 2011;
Sørensen 2008; Weigmann et al. 2013). Digital illustration
techniques have numerous advantages over traditional inking
techniques (Bouck and Thistle 1999; Fisher andDowling 2010).
The easy and quick possibility to undo strokes that have turned
out imperfect, for instance, is a major time-saving factor. Vector-
graphics software allows manipulation of the actual drawing
after the completion of the lines (Holzenthal 2008). It further
permits compact data files and the possibility to scale an illus-
tration without losing information or changing line weights, if
unwanted. Manuals to the basically relevant scientific drawing
techniques using a pen tablet and Adobe® Illustrator® (AI) are
available (Barber and Keane 2007; Bouck and Thistle 1999;
Coleman 2003; Holzenthal 2008). Through the application of
macroinstructions (macros) and the brush tool, the illustration of
frequently occurring features, such as setae, can be significantly
sped up (Coleman 2009).

For transmitting a general impression of the shape and form
of an organism or parts of the latter, line drawing is a powerful
technique (Honomichl et al. 1982). There are instances where
a purely line-based illustration providing a contour and certain
important protruding features are fully sufficient. That is es-
pecially the case when the illustrated object is flat or has an
otherwise even surface. However, a weakness of line drawings
in general is the lack of depth.

Most biological objects comprise more than plain surfaces;
edges, convex or concave areas, as well as form, and texture
may be of significance (Dalby and Dalby 1980). To overcome
this shortcoming and even emphasize certain features, shading
techniques can be applied. They create the impression of three
dimensionality (3D), texture, and to some degree even color
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(Dalby and Dalby 1980). Stippling is the method of choice to
produce shaded line art in science (Briscoe 1996). It is
achieved by producing dots into the line drawings and gener-
ates the illusion of greyscale within the preferable (Dalby and
Dalby 1980) black-and-white (B/W) regime by varying den-
sities of dots (Honomichl et al. 1982; Zweifel 1988). Stippling
may be time consuming compared with plain line drawings,
but it provides full control over the application of shading and
highly realistic results are achievable (Sousa 2003). Stippling
is therefore a widely applied method in biological sciences
(e.g., Brandt andWägele 1988; Meißner and Hutchings 2003;
Kieneke et al. 2008; Miljutina and Miljutin 2012; Köhler and
Criscione 2013; de Zeeuw et al. 2013; Moravec et al. 2014).

In this paper, we describe methods for vector-based stip-
pling. These fulfill all requirements from scientific illustra-
tions, such as reproducibility, clarity, and scalability. They
allow shading without compromising the clarity, simplicity,
and storage-saving advantages of B/W (e.g., bitmap) images.

They are further advantageous over traditional stippling using
ink because of the possibilities to electronically manipulate
size and orientation. High flexibility in plate preparation as
well as easy correction possibilities are further improvements
(Bouck and Thistle 1999). Moreover, we describe a signifi-
cantly time-saving automation technique.

Materials

Any computer with at least 1,300MHz processor, 1 GBRAM,
and USB port can be used. A second monitor is advisable. For
this paper, both Apple and Windows operation systems in
combination with Wacom Intuos pen tables (models 3 A4
(PTZ930) and 4 A4 (PTK840)) were used. The required
hard- and software runs on any of the widely applied operation
systems (Microsoft Windows, Macintosh OS, Linux).
Throughout the guidelines, we provide keyboard shortcuts in

Fig. 1 Overview over the
AUTOMATION workspace in
Adobe Illustrator. a The
workspace selection panel is
located near the top right corner
of the window. b The Brushes
menu. c The Actions panel. d The
Layers menu. e The Stroke panel
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brackets that are applicable for both Apple and Windows
systems. The Apple-specific ⌘ key is used synonymously
with the Windows Ctrl key. The Shift key is represented by⇧.

The underlying scientific illustrations were created by fol-
lowing the methods described by Coleman (2003, 2009), and
their creation is not part of this documentation. Adobe®
Illustrator® (AI) CS5 (version 15.0.0 and 15.0.2) was used
during the development of the methods. All methods de-
scribed herein were successfully tested in the still widely
applied AI CS 4 and the latest AI CS 6 version as well. We
recommend to use the Automation workspace (Fig. 1a) be-
cause all necessary menus are found therein.

Manual stippling

1. Open AI and attach the drawing tablet.
2. Load a vector drawing, e.g., one prepared following

the guidelines by Coleman (2003, 2009) (File➜
Open; or ⌘ O).

3. Open the brushes panel (Fig. 1b) and select the 3 pt. round
brush (Artistic_Calligraphic library) (Fig. 2a). Adjust the
stroke size to 0.25 pt. (Fig. 2d).

4. Add a row of dots by tapping on the tablet. The dots
should evenly distributed (ca. 0.5 mm distance).

5. Add a second similar row of dots parallel and alternating
to the first row.

6. Add a third row parallel and alternating to the second row.
7. Etc.

Following this pattern, the shade will look even without
any gradation (Fig. 3a–c). If a desaturation is desired for this
tone to receive a gradation, the next steps need to be followed
(Fig. 3d–g).

8. Add another parallel row of dots with more distance to the
previous row.

9. Use the same distance for one or more additional rows.
10. For a stronger desaturation effect, double the distance

between the dots in another (set of) row(s)—alternating
with every second dot in the previous row.

11. This can be deliberately expanded.

Automated stippling

Stippling can be semi-automated through brushes and an
appropriate macro (called “Action” in AI terminology). The
latter method is described in this section. We are providing
exact values that lead to the example brushes in the Electronic
supplementary material.

Creating stippling brushes

1. Open a new document (⌘ N).
2. For easier navigation, activate the ruler (View➜ Ruler➜

Activate Ruler; or ⌘ R).

Fig. 2 The Brushes panel. a 3 pt.
Round brush. b Create New
Brush. c Selected object options.
d The suggested size for a single
stipple is 0.25 pt

Adding depth to line artwork by digital stippling 329



3. Use the brush tool (b) and select the round-3 Pt brush.
Adjust the stroke size to 0.25 pt. (Fig. 2d).

4. Create a random dot by tapping on the pen tablet and a
second one 0.6 mm to the right and 0.7 mm below
(Fig. 4a; this is the fundamental fragment of the simplest
stippling pattern).

5. Select the pattern by either using the direct selection tool
(A) or the lasso tool (Q).

6. Open the brushes panel (Fig. 1b) and add a new brush by
clicking the new brush button on the bottom of the panel
next to the bin button (Fig. 2b). Select the art brush type
(Fig. 5a) and name the brush (in this case, stippling basic).
The brush scale options should be set to stretch to fit
stroke length (Fig. 5b).

Make sure the stroke direction is correct and press OK
(Fig. 5b).

Following the guideline above produces a rather simple
stippling pattern. It is suitable, for example, for slight
shadings or to pronounce layer separation (see, e.g., anten-
nae and uropods in Fig. 6b). This pattern can become more
complex by adding more rows of dots and gradients. Once
a pattern is established (e.g., by following steps 1–6 above)
this pattern can be used as template to easily produce
derivatives. Copies can be made and transformed by up-
or down scaling with or without keeping the aspect ratio. A
large library of stippling brushes can thus be generated
quickly.

We recommend preparing a set of at least four to six
stippling brushes. In Table 1 (Electronic supplementary
material), coordinates for six further stippling patterns are
presented. Pattern no. 7 (Concavity) is different to all other
patterns in that this special pattern is simulating a concav-
ity (Fig. 6c).

Once a brush library is generated, it can be saved
(Fig. 7a) and is then available for further illustrations
(Fig. 7b). An exemplary brush library containing those
brushes presented here is provided in the Electronic
supplementary material.

Creating a stippling action

Stippling brushes have a certain length defined by its under-
lying pattern fragment. Longer homogeneous stippling is
produced by using the dashed line function which produces
repetition of the pattern fragment. The dash length has to be
set to equal the length of the pattern fragment and the gap
length has to correspond to the necessary distance between
two such fragments. Actions allow quick adjustments of these
pattern-specific parameters so the generated stippling pattern
is homogeneous. Actions are AI-specific macros. Once a
brush is saved to the brush library, it is recommended to
program a corresponding action.

1. In the actions panel (Fig. 1c), create a new set and name it
stippling (Fig. 8a).

2. Create a new action within this set and name it stippling
basic (Fig. 8b). Assign the function key [⇧ F9]. Click
record (Fig. 8b).

3. Open the stroke panel (Fig. 1e). Set weight to 1 pt. and
check the dashed line box (Fig. 9a). To the right of this

Fig. 3 Example of how to build up shading through manual stippling. a
Start with one row of equally-spaced dots. b, cAdd second and third rows
alternating to the previous row. d–g For a desaturation effect, add more
rows but with increased distance between them. For a stronger
desaturation, double the spacing between the dots in another
(set of) row(s)—alternating with every second dot in the previous row.
This pattern can be deliberately expanded

Fig. 4 Steps for creating semi-automated stippling (not to scale). a Two
stipples are the basis for a simple repetitive pattern, Stippling basic. bWhen
the stippling brush is applied without using the proper type of dashed line, a
stretched stippling brush appears. c After application of the corresponding
action, the stretched brush is turned into a symmetric, repetitive pattern. dThe
end of the stroke may be distorted. This can be adjusted by extending or
shortening the vector at the terminal anchor point
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box, check preserves exact dash and gap lengths
(Fig. 9b).

Set the dash length to 2.5 pt. and the gap length to 0.5 pt.
(Fig. 9c).

4. Stop recording by clicking the stop button (Fig. 8c) next
to the red record button on the bottom of the actions
panel.

5. Use the brush tool (B), select the brush stippling basic and
draw a line; the dots appear stretched (Fig. 4b).

6. Press [⇧ F9] and the stretched line are converted into a
repetitive pattern (Fig. 4c).

7. The end of the stippling turns out squeezed when the
length of the underlying vector does not exactly equal a
multiple of the fragment length (Fig. 4d). If this is the
case, the length of the vector should be altered by moving
the last anchor point.

Once the action set is generated, it can be saved and is
available for further illustrations (Fig. 8d–f). This action cor-
responds only to the stippling-brush pattern described above

as well as derivatives with similar fragment length and spacing
between dots. We recommend preparing actions correspond-
ing to each individual stippling type (Table 2 of the Electronic
supplementary material). The actions presented here are
available as Electronic supplementary material.

Adding stippling to a drawing

1. Open AI and attach the pen tablet.
2. Load a vector drawing prepared following the guidelines

by Coleman (2003, 2009) (File ➜ Open; or ⌘ O).
3. Create a new layer in the layer panel by clicking create

new layer next to the bin symbol and name it (e.g.,
stippling; Fig. 10a). Working with layers has many ad-
vantages. First of all, it helps to organize the document
properly. Then, the order of the layers represents an object
hierarchy (stacking order). Furthermore, layers can be
selectively locked, masked out and dimmed (amongmany
other attributes) to provide great working comfort.

4. Use the brush tool (B) and select one of the previously
prepared stippling brushes.

5. Activate the corresponding action.

Fig. 5 How to create a brush. a
The pattern is saved as Art brush.
b The options Stretch to Fit Stroke
Length and the brush Direction
are set in the Art Brush Options
window
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6. Trace those lines that need stippling.
7. If the stippling pattern is upside down (Fig. 11d), you can

either draw the line in the other direction or preferably
open the options for selected object window (Fig. 2c) by
clicking the button on the left to the create new brush
button. Choose flip across (Fig. 11e).

8. Adjust the anchor points for optimal coverage and
avoiding a compressed end of the vector.

Line-parallel stippling over large areas

In cases where a large area that is parallel to a line needs
homogeneous stippling, it may be easier to copy this line and
transform it into a stippling pattern.

1. Select the whole line or parts that need stippling with
either the direct selection tool (A) or the lasso tool (Q)
(Fig. 12a).

2. Copy this line (⌘ C) and paste it behind the original line
(⌘ B).

3. Use the selection tool (V) and move the copied line in the
preferred position next to the original line (Fig. 12b).

4. Open the brushesmenu and choose one of the previously
prepared stippling brushes (Fig. 12c).

5. Make adjustments if needed (Fig. 12c).
6. Go to the layers menu and drag the selection to the

stippling layer (Fig. 10b).

Stippling within a closed line

Where roundish structures that are represented in a draw-
ing by closed lines, such as any form of operculum
(Fig. 6c) or microfungal conidia (Barber and Keane
2007), stippling may be used to simulate bulge form. To
achieve this, parallel stippling on the inside of the closed
line is required.

1. Select the whole line with either the direct selection tool
(A) or the lasso tool (Q) (Fig. 11a).

2. Copy this line (⌘ C) and paste it behind the first (⌘ B).
3. Scale the selection (Object ➜ Transform ➜ Scale) to

≤99 % depending on the used stippling brush (Fig. 11e)
and diameter of the closed line.

4. Open the brushes menu and transform the line into a
stippling brush (Fig. 11d).

Fig. 6 Plain versus stippled
vector illustrations exemplified by
the isopod (Crustacea) species
Macrostylis scotti Riehl and
Brandt 2013. a Plain illustration
without any shading. b Same
illustration as a but with stippling
added. Various types of brushed
stipplings as well as manual
stippling were applied.
c The second female pleopods
(operculum) with concavities
(stippling pattern no. 7) on the
surface
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5. Make adjustments if needed (Fig. 11c, d).
6. Go to the layers menu and drag the selection to the

stippling layer (Fig. 10b).

Scaling of stippled illustrations

One major advantage of vector-based graphics is its high
reproducibility. The final size of the illustration can be adjust-
ed without compromising the quality even after the actual
drawing is completed (Object ➜ Transform ➜ Scale)
(Fig. 13a). There is a much higher flexibility with regard to
adjusting line weights etc. in the process of plate arrangement.
Unlike pixel-based graphics, vector graphs can be infinitely
enlarged without losing resolution. Moreover, scaling may

Fig. 7 How to save and load a brush library. A click on the upper right
corner of the Brushes panel opens a dropdownmenu. a Save Brush Library
opens an explorer window to select the proper location for storing the
library. b Custom-made libraries can be loaded by clicking onOther Library

Fig. 8 Every type of stippling
brush needs a corresponding
Action. a Actions are saved to a
New Set, which can be called
Stippling. b For every New action
that is recorded, a unique name
and Function Key should be
assigned. c To stop recording,
press the Stop button. d To save or
load an Action, open the Actions
Options. e Then press Save
Actions or f Load Action

Fig. 9 The Stroke panel. a Checking this box change a line into a dashed
line. b For stippling brushes, it is recommended to check Preserves exact
dash and gap lengths. c The dash and gap distance is manually adjustable
and proper values depend on the underlying stippling pattern
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change the appearance of the illustration, if desired, by selec-
tively excluding strokes and brushes from the scaling process.
When the box scale strokes and effects in the scaling panel is
checked (Fig. 13b), lines and brushes change their appearance
equivalently to the overall scaling. Thus, when the drawing is

scaled down to 50 % of its original size, a 1-pt. outline
becomes 0.5 pt. When the box scale strokes and effects is
unchecked, lines do not change their weight and brushes do
not change their appearance during scaling. In the
abovementioned case, the line weight would double relative
to the size of the drawing. This is also relevant for stippling,
because manually applied dots and stippling brushes may
behave differently depending on the applied settings.
However, we present three ways of scaling artwork that con-
tains stippling:

First of all, checking the box scale strokes and effects
allows for a straight-forward scaling approach where all rela-
tive values remain constant. Using this method, manual and
brushed stipples are equally affected.

At the same time, AI provides a tool to change the relative
dimensions of the stipples, without changing their relative
positions while the overall size of the drawing is altered. The
expand appearance function (Object➜ Expand appearance)
converts the stippling brushes as well as manually applied dots
into circular paths filled with black color. Thus, the dimen-
sions of the black dots are not defined by a stroke anymore but
by the diameter of the circular vector. Given that during
scaling the relative positions of the paths and anchor points
always stay identical, downscaling in this case means
downsizing the stipples and vice versa. This implies that as
long as the box scale strokes and effects remains unchecked,

Fig. 10 The Layersmenu. a Create aNew Layer. b Selected paths can be
moved to different layers

Fig. 11 Excerpt of a round closed line that is supposed to get a stippling.
a Select a path, create a copy behind the template. b Scale selected path to
99% of its original size. c The path should now lie within the round
structure. dConvert path into a stippling brush by selecting an appropriate

pattern from the brushes library. e To flip over the stippling brush when it
has turned out upside down, check the Flip Across box in the Stroke
Options window. f The ready stippling
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any scaling changes the appearance of the individual dots.
Going back to the previous example of the drawing that is
scaled down to 50 % of its original size: a 1-pt. outline retains
its weight; the dots of the stippling, however, are reduced to
50 % of their original diameter.

As AI may automatically group dots of the brushed stip-
pling when the expand appearance function is applied, scal-
ing may cause distortion of the stipple positions. To counteract
this, select all stippling patterns (lock all layers, except the
stippling layer; then press ⌘ A) and ungroup (Object ➜
Ungroup; or ⌘ G) the selection. To ensure that also groups

nested within groups have ungrouped, the ungrouping may
need to be repeated.

Finally, the Transform each tool (Object ➜ Transform ➜

Transform Each; or⌘⇧ D) allows altering the intensity of the
shading by scaling the selected dots individually. As a prereq-
uisite for this approach, it is necessary to convert all stippling
brushes to circular paths beforehand using the expand
appearance tool.

Discussion

Line drawings involve selectiveness and emphasis to certain
aspects of the illustrated objects (Dalby and Dalby 1980).
Stippling is a method that allows emphasizing structures
interpreted as relevant by the scientist. It provides a high
degree of freedom and adaptability. By applying a digital
approach to stippling (Riehl and Brandt 2013; Riehl et al.
2012, 2014), this technique has been brought up to date
concordant with widely applied digital line-drawing methods
(Bouck and Thistle 1999; Coleman 2003, 2009).

However, manual stippling can be relatively time consum-
ing. Another general difficulty with manual stippling is to
create homogeneous tinges over large areas (Honomichl
et al. 1982). We hence developed a method that allows rela-
tively straight contours to be shaded reasonably quick: the
automated stippling presented in this paper guarantees both, to
significantly speed up the process and to produce homoge-
neous shades. It however fails to produce satisfactory results
where the path underlying the stippling is heavily curved. In
particular in broad stippling brushes, the dots of the outer rows

Fig. 12 Automated stippling exemplified on a ventral head drawing of a
macrostylid isopod. a Select a path. b Copy the selected path behind the
original template. cMove the copied path to be parallel to the template. c

Convert line into a stippling brush by selecting the desired pattern from
the brush library. d After applying the corresponding action command
this stippling is adjusted. e Magnification from d

Fig. 13 How to scale vector illustrations that contain stippling patterns. a
Uniform scaling is required to keep length-width ratios of the illustration.
b The box Scale Strokes and Effects should be checked when lines and
brushes are supposed to change their appearance equivalently to the
overall drawing
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get distorted easily. This may cause accentuating effects that
are not desirable. To a certain degree, this might be tolerable.
In curved regions, however, it is recommended to link straight
sections produced by the automated method with manually
applied stipples.

The methods described in this paper provide a general
introduction to our new approach. Any values provided in this
paper can be changed to fit the individual requirements. The
method provides an alternative to another recently described
method (Barber and Keane 2007) that applies filters in Adobe®
Photoshop® to automatically generate stippling. One disadvan-
tage of the latter method, in contrast to our approach, lies in the
computer-generated dot distribution that produces randomly
variable distances and often overlapping of the individual dots
which is generally not desirable (Sousa 2003). The method
described herein allows full control over dot distribution.
Likewise, their pixel-based approach does not provide the
reproducibility and scalabilities inherent in vector drawings.

It should be noted that the freely available software
Inkscape (http://www.inkscape.org; among others; see, e.g.,
Barber and Keane 2007 and references therein) offers a
suitable alternative to AI with regard to the manual stippling
approach (see Riehl et al. 2014) and digital illustrations in
general (see, e.g., Wilson 2008). However, the methodology
differs regarding the tools and settings and possibilities to
automate stippling need yet to be explored.
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